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Abstract

These Application Notes describe the configuration steps required to integrate Grandstream
GXV3240 and GXV3275 Multimedia IP Phones for Android™ with Avaya IP Office.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate Grandstream
GXV3240 and GXV3275 Multimedia IP Phones for Android™ with Avaya IP Office.

2. General Test Approach and Test Results
The interoperability compliance testing included both feature and serviceability testing.

The featured testing focused on verifying the ability of the Grandstream Multimedia IP Phones to
register as SIP endpoints with Avaya IP Office, establish voice and point-to-point video calls,
and exercise various telephony features (e.g., hold/resume, transfer, conference, etc.).

The serviceability testing focused on verifying the ability of the Grandstream Multimedia IP
Phones to handle various outages such as network disconnects and server/phone reboots.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
Interoperability compliance testing covered the following features and functionality:

e Successful registration of the Grandstream Multimedia IP Phones with Avaya IP Office.

e Voice calls between Grandstream Multimedia IP Phones, Avaya 6200 Series analog
telephone, Avaya 9500 Series digital telephone, Avaya 1600 Series IP Deskphones,
Avaya 9600 Series IP Deskphones (H.323), Avaya E129 SIP Deskphones, Avaya E169
Media Station (SIP), and Avaya Communicator for Windows.

e Point-to-Point video calls between the Grandstream Multimedia IP Phones and Avaya

Communicator for Windows.

G.711MU, G.711.A, G.729A, and G.722-64k codec support.

Guest login/logout

Caller ID and display updates.

Direct Media Path (i.e. media shuffling).

Proper recognition of DTMF tones by navigating voicemail menus.

Proper operation of voicemail with Message Waiting Indication.

Telephony features including: Mute, Hold/Resume, Transfer, Conference, Music on

Hold, Call Forwarding, Call Park, Call Pickup, and Automatic Redial.

The serviceability testing focused on verifying the ability of the Grandstream phones to handle
various outages such as network disconnects and server/phone reboots.
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The wireless functionality of the Grandstream phones was not tested.

2.2. Test Results
The Grandstream Multimedia IP Phones successfully passed compliance testing.

2.3. Support
Grandstream can be reached using the information provided on the following web sites:

e General Contact Information: http://www.grandstream.com/company/contact-us
e Support Requests: http://esupport.grandstream.com/support/customerportal/login.php
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3. Reference Configuration

Figure 1 illustrates the test configuration used to verify Grandstream Multimedia IP Phones
integration with Avaya IP Office. The configuration consists of an Avaya IP Office Server
Edition Primary Server, an IP500 V2 Expansion System, and connectivity to a simulated PSTN
via an ISDN-PRI trunk. Voicemail Pro was used as the voicemail system. The Grandstream
endpoints registered with Avaya IP Office as SIP Users.

E Avaya IP Office 500 V2 Avaya IP Office
Expansion System Server Edition
Avaya 6200 Avaya 9500 (10.64.21.68) (10.64.21.67)
Series Analog Series Digital
Phones Telephones ‘
m 3 1
Avaya E129 Avaya E169 Avaya 1600 ’
SIP Deskphone Media Station Series IP
(SIP) Deskphones
(H.323)
Avaya Grandstream Grandstream
Avaya 9600 Series Communicator GXV3240
IP Phones for Windows QXIS
(H.323) (SIP)
Grandstream Endpoints
Figure 1: Grandstream Multimedia IP Phones
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software Release/Version
Avaya IP Office Server Edition (Primary 9.1.0.0 Build 437
Server)
Avaya IP Office IP500 V2 (Expansion 9.1.0.0 Build 437
System)
Avaya Voicemail Pro 9.1.0.0 Build 166
Avaya 6200 Series Analog Phones -
Avaya 9500 Series Digital Telephones R0.55
Avaya 1600 Series IP Deskphones 1.3.6
Avaya E129 SIP Deskphones 1.0
Avaya E169 Media Station 1.1
Avaya 9600 Series IP Deskphone (96x1 — | 6.4
H.323)
Avaya Communicator for Windows 2.1
Grandstream GXV3240 and GXV3275 Hardware Revision: V1.7A (GXV3240)
Multimedia IP Phones V1.4B (GXV3275)
System Version: 1.0.3.25
Android Version: 4.2.2

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start = All Programs - IP Office & Manager to launch
the application.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane, and show the Details pane on the right side. Since the
Group Pane has been omitted, its content is shown as submenus in the Navigation pane. These
Navigation and Details panes will be referenced throughout the Avaya IP Office configuration.
All licensing and feature configuration that is not directly related to supporting the Grandstream
phones is assumed to already be in place.

In the sample configuration, Primary was used as the system name of the Primary Server, and
Expansion was used as the system name of the Expansion System. All navigation described in
the following sections (e.g., License) appears as submenus underneath the system name in the
Navigation Pane.

These Application Notes assume that basic Avaya IP Office administration has already been
performed (e.g., Avaya endpoints, network configuration, trunks, routing, short codes, etc.).
Consult Reference [2] for further basic configuration details if necessary. The procedures shown
in this section include:

e Verify IP Office license

e Obtain LAN IP address

e Administer SIP registrar

e Administer SIP extensions
e Administer SIP users

Note, the sub-sections below illustrate the configuration needed to successfully register a
Grandstream phone with the Primary Server. However, for any Grandstream phones that will be
registered with the Expansion System, the same configuration steps must be performed on the
Expansion System. During compliance testing, two Grandstream phones were registered with
the Primary Server and two were registered with the Expansion System.

5.1. Verify IP Office License

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a 3rd Party IP Endpoints License with sufficient capacity, click License
in the Navigation pane. Confirm a Valid license exists with sufficient Instances in the Details
pane. The License Keys have been pixelated in the image below for security purposes.
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5.2. Obtain LAN IP Address

To access the LANL1 settings, first navigate to System - <Name>, where <Name> is the system
name assigned to the Avaya IP Office. Next, navigate to the LAN1 - LAN Settings tab in the
Details Pane. Make a note of the IP Address, which will be used later to configure the

Grandstream phones.
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5.3. Administer SIP Registrar
Continuing from the previous section, navigate to the LAN1 - VolIP tab in the Details Pane.
Verify SIP Registrar Enable is checked. A valid Domain Name can be entered for SIP
endpoints to use for registration with IP Office. During compliance testing, the Domain Name
was left blank, and SIP endpoints used the LANZ1 IP address for registration.
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5.4. Administer SIP Extensions

To add a new SIP extension, right-click on Extension in the Navigation pane and then select
New -> SIP Extension from within the pop-up menu (not shown). For Base Extension, enter
the SIP extension to be used for the Grandstream phone (e.g., 241). Retain the default values in

the remaining fields.
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Select the VolP tab, and retain the default values in all fields as shown below. Repeat this
section to add additional SIP extensions as desired.
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5.5. Administer User

To add a new User, right-click on User in the Navigation pane, and then select the New option
from within the pop-up menu (not shown). Enter a desire value for Name. For Extension, enter
the extension from Section 5.4.

(W Avays 1P Office Morager tor Server Eition Praary [910.437]

Fe it View ﬁl’ut Help
LUl ROFN va@
Priman, - | User =i 241 GSGXV3ZTS -
’: :g‘;"":’m@('” * | e 1| oND | Sher Codes | Sowce t 11 g | Ovai v | Veice Riecordiog | Bunton Prog I
=% Sohsion Name GSENVINTS =
1 t User 19)
i Group(l) Passwond
i 9% Sheet Codedd?) |
= Ouectory ) | Contium Password
7 Yime Profilest) 2
o . ‘“‘"‘Y“ Codell) Conference FIN
" '; :":'ml ‘IA | Cenfirm Cenfetence PIN ’
= Prirmwry | Aceount Status Enable -
= o Sptem (1) | |
- Full Naeme Grandstream GXVIDS
E-11 Line 4)
& Control Unit 5) Ertemion 24
« & Btergon @)
i eas) Fread Address |
l';:‘;u;; || Locale | -
244 284 =
245245 | Priomy B : |
246 205 | System Prane Rigras | None =
M7297
248 20 Peofite | Basic User . o
242 GSGAVIM0
241 GSGVADS :
i 8 Geowp 1) d [ ook || comcs || Hep |
R Sheot Code 520 3
L 9
MJH; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 22

SPOC 6/16/2015

©2015 Avaya Inc. All Rights Reserved.

Grandstream_IPO




Navigate to Telephony = Call Settings tab in the Details Pane. Check the box for Call
Waiting On and retain the default values for the remaining fields on this tab.
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Navigate to Telephony = Supervisor Settings tab in the Details Pane. Enter a desired Login
Code. This Login Code will be needed to configure the Grandstream phone.
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5.6. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

6. Configure Grandstream GXV3240 and GXV3275
Multimedia IP Phones for Android™

It is assumed that the basic configuration for the Grandstream phones has already been
implemented and that the phones are ready for the integration with Avaya IP Office. The sub-
sections below provide only the steps required to configure the Grandstream to interoperate with
Avaya IP Office.

Note: Only the configuration steps required to integrate the Grandstream GXV3240 phone
model with Avaya are shown in the sub-sections below; however the same steps are required and
applicable to the Grandstream GXV3275 phone model.

6.1. Web Interface

Access the phone web interface by opening a web browser and entering the following URL.:
http://ip-address, where ip-address is the IP address of the phone. Log in using appropriate
credentials.
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http://ip-address/

| GXV3240 x\-ig

(. &‘10'64'21'244 c | Q Search wBE 3 A 4 ®| =

GXV3240

Enterprise Multimedia Phone for Android

Username

Password

Language

After making and saving any configuration changes throughout the remainder of Section 7, an
Apply button will appear at the top of the web interface. Click the Apply button (not shown) to
immediately apply the changes.
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6.2. Configure General Settings

Click the Account tab and select an Account sub-tab to configure (e.g., Account 1). Click
General Settings on the left. Configure the following parameters:

Account Active: Check the Yes box.

Account Name: Enter descriptive text.

SIP Server: Enter the IP Office LAN 1 IP address.

SIP User ID: Enter the extension created in Section 5.4.

SIP Authentication ID: Enter the extension created in Section 5.4.

SIP Authentication Password: Enter the login code for the User created in Section 5.5.
Voice Mail UserID: Enter the Avaya IP Office short code used to access Voicemail Pro
(e.g., *17). Configuration of short codes and Voicemail Pro is outside the scope of this
document. The mailboxes for the Grandstream phones are configured the same as Avaya
phones.

e Name: Enter descriptive text (optional).

Use the default values for the remaining fields. Click the Save button at the bottom of the
screen.

GXV3240
-- Enterprise Phone Administration Interface

Aecount 1| Accownt 2 | Accownt 3 | Account 4 | Account 5 | Account 6

Account Active ¥iYes
Account! Kame PO
SIP Server 10642167
SIP User 1D 41
SIP Authentication 1D ol
3IP Authentication Password
Voice Mail UsanD
Name
Show Account Name Only

Tel URY

MJH; Reviewed: Solution & Interoperability Test Lab Application Notes 16 of 22
SPOC 6/16/2015 ©2015 Avaya Inc. All Rights Reserved. Grandstream_IPO



6.3. Configure SIP Settings

Continuing from the previous section, click the SIP Settings tab on the left. Check the Yes box
for SIP Registration and SUBSCRIBE for MWI. Use the default values for the remaining
fields. Click the Save button at the bottom of the screen.

GXV3240

-- Enterprise Phone Administration Interface

" Advanced Settings  Maintenance

SIP Regisirabon

Unragister Before New Regisiration
Register Expwration (m)

Reregsier before Expiraton (5)
Registration Retry Wall Time (s)
Local SIP Port

SUBSCRIBE for M\
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6.4. Configure Code Settings

Continuing from the previous section, click the Codec Settings tab on the left. The settings on
the screen below show that values that were used during compliance testing; however, Preferred
Vocoder settings were modified occasionally during the testing to test various codecs. Check
the box for Enable RFC5168 Support. After making any changes, click the Save button at the
bottom of the screen.
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GXV3240
-- Enterprise Phone Administration Interface

Accowt 1| Account 2 | Account 3 Account 4 | Account 5 |

DTMF Jinaudic ¥IRFC2833 |

DTMF Payicad Type 107

Pretemed Vocoder

Avafabie
(72632
iBC
Opus

ILBC Frame Sie
G726-32 ITU Paylad
G726-32 Dynamk PT 126
Enable RFC5168 Support Wives
H 264 Image Ske T20P
H 264 Protie Type Baselne Profile
Video B Rate 2046 kbps
SOP Bandwioth Athnbute Media Level
H.264 Payioad Type )
SRTP Moge DOrsable
SHTP Key Lengin AES 128825 bit
Enable SRTP Key Lit Time vYes
Stence Suppression Yes
Voice Frames Pes TX

Mier Bulles Mapomum (ms)

RTCP Destination

6.5. Configure Packetization Mode

By default, the Grandstream phones support packetization mode set to 1. At the time of testing,
the Avaya video endpoints did not support packetization mode set to 1. Therefore, the
packetization mode value on the Grandstream phones was changed to 0.
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To change the packetization mode value on the Grandstream phone, open a secure shell session
to the phone’s IP address. Log in using appropriate credentials. The commands required to
change the value (and output) are shown below.

GXV3240 > config
CONFIG > get 957

957=1

CONFIG > set 957 0

Set 957=0

CONFIG> commit

nvram commited

CONFIG > exit

GXV3240 > reboot

You have chosen to reboot.

Do you want to continue (y/N)? y

7. Verification Steps
This section includes steps that can be followed to verify the configuration.

7.1. Verify Point to Point Audio and Video Calls

Place point to point audio and video calls between the Grandstream phones and Avaya
endpoints. Verify 2-way audio as well as 2-way video for the video calls.

8. Conclusion

These Application Notes describe the procedures required for the Grandstream Multimedia IP
Phones to interoperate with Avaya IP Office to support the reference configuration shown in
Figure 1. Refer to Section 2.2 for testing results.
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9. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] Deploying IP Office Platform Server Edition Solution, Release 9.1, Issue 02.07, April,
2015.

[2] Administering IP Office Platform with Manager, Release 9.1.2, Issue 10.09, April, 2015.

[3] Using IP Office Platform System Status, Document Number 15-601758, Issue 10e, April
14, 2015.

[4] Administering IP Office Platform Voicemail Pro, Document Number 15-601063, Issue
10d, March 25, 2015.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 06c, April 16,
2015.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Grandstream products may be found at:
http://www.grandstream.com.

[6] GXV3240 IP Multimedia Phone for Android™ Administration Guide
[7] GXV3275 IP Multimedia Phone for Android™ Administration Guide
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